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Introduction 

 
SNAP-Plus is a Microsoft Windows® based Nutrient Management Planning software 

program designed for the preparation of nutrient management plans in accordance with 
Wisconsin’s Nutrient Management Standard Code 590.  The program is available free of charge 
for download from the "Current Version" link.  This release of Snap-Plus addresses issues found 
since the September 2007 version 1.121.  SNAP-Plus will calculate:  

• Crop nutrient (N, P2O5, K2O) recommendations for all fields on a farm taking into 
account legume N and manure nutrient credits consistent with University of Wisconsin 
recommendations 

• A RUSLE2-based soil loss assessment that will allow producers to determine whether 
fields that receive fertilizer or manure applications meet tolerable soil loss (T) 
requirements. 

• A rotational Phosphorus Index value for all fields as required for using the P Index for 
phosphorus management. 

• A rotational P balance for using soil test P as the criteria for phosphorus 
management. 

Updates are released periodically to add new features and bug fixes.  The main 
changes and improvements available in the current version of Snap-Plus are listed 
below by the menu or screen where they appear in the program. 

 
File Menu 

 
Note: When you enter data for a new farm, select "New" which means a "New Client. 

"Split Multi-farm Databases – Some users have experienced problems caused by too many 
farms in one database.  This slows the program calculations, causes the computer to time-out 
during report construction, and makes sharing a single farm’s data electronically difficult.   
The solution is to multi-farm databases into single farms or operations using the Snap-Plus copy 
wizard.  The example below shows the Mayer and Ledeboer farms are included in a single 
database as shown in Figure 1.   

 
Figure 1.  Choose "File" then "Copy" for copying or splitting databases. 
 
1/ Nutrient Management Specialist, Wis. Department of Agriculture, Trade and Consumer 
Protection 
 
2/ Wisconsin Phosphorus Index and Snap-Plus Project Coordinator, Dept. of Soil Science, Univ. 
of Wisconsin-Madison, 1525 Observatory Dr., Madison, WI, 53706. 
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Split Multi-farm Databases Continued – Follow the steps below shown in Figure 2. 

 
Figure 2.  Select “Finish” to complete the database splitting or copying. 
 
 

Edit Menu 
 

Preparer Info – Nutrient management planners can place their contact information in this 
part of the edit menu as shown in Figure 3. 

 
Figure 3.  Nutrient management planners can place their contact information here. 
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Fertilizer List – The nutrient management planner has a single “master" fertilizer list for all 
Snap-Plus databases on a user's computer.  The list can be edited from the "Edit" menu shown in 
Figure 4. 

 
Figure 4.  Select Fertilizer List to add or delete fertilizers from the master Fertilizer List. 

 
 

Tool Menu 
 

Update all fields – Calculate soil loss, P management and other items on the “Cropping” 
screen using this tool shown in Figure 5.  All fields can be updated if all the required information 
is entered.  Also note that the Rotation Wizard can be accessed from the Tools menu as well as 
the Cropping screen. 

 
Figure 5.  Update all field calculations at once using this tool. 
 
 

Report Menu 
 

Spreading and NM Sorted by Crop – This report combines the reports of the spreading 
plan and the NM plan with specific nutrient credit information.  For each crop type the report 
includes: name, acres, field slope(%), soil series, map unit, N restriction, prior crop, the specific 
crop year and crop, yield goal, tillage, product and its analysis being applied, application rate and 
method, N-P2O5-K2O credit, total amount applied for the field, soil test P and K (ppm), UW soil 
test recommendation for N- P2O5- K2O, planned application and credits for N- P2O5- K2O, over 
or under UW recommendations for N- P2O5- K2O.  The report calculates total acres of each 
crop, total application volume of each source and the season in which it is applied.  The bottom of 
the report calculates the total planned acres, total planned applications by source for the farm, 
total manure volume (tons, gallons), total planned manure applications, and remaining manure. 
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Figure 6.  The Spreading and NM Sorted by Crop report provides easy-to-read nutrient 
recommendations.  Other useful reports are pointed out above. 
 

 Soil Test Report – The soil test report (not shown) has a Short Version option that will 
provide the following information for each field using the most recent soil test report entered for 
that field: field name, acres, soil map unit, soil name, soil test, soil test lab, lab sample number, 
number of sample, acres per sample, pH, OM%, P ppm, K ppm, S ppm, BpH, and CEC. 

 
Spreading Excess – This report lists the fields that have N applications in excess of 590 

Standard allowances for the report year along with the explanations for each over-application as 
shown in Figure 7.  This report can not be generated for crop years prior to 2008 which is when 
the excess N warning system began. 
 

Figure 7.  Snap Plus will highlight N applications that exceed t he 590 standard in red on the 
Cropping screen and in the Spreading Excess report.  
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Options Menu 
 

Check for new versions - Snap-Plus can automatically check for the most current version at 
startup, if your computer has a web connection.  This feature is turned off at the time of 
installation.  Users can turn it on from the "Options" menu item shown in Figure 8.  

 
Figure 8.  After Snap Plus installation, click to turn-on the “version upgrade check” so you will 
know if you are working on the latest version. 
 
 

Help Menu 
 

2005 NM Plan Checklist – Nutrient management planners should use this form as a 
minimum list of items that must be addressed in completing a 590 NM plan for local ordinances, 
USDA EQIP programs, DNR WPDES permits and cost share, DATCP programs, and voluntary 
farmer training.  This form and others are shown in Figure 9.   

 
Editable Emergency Response Form – To help make emergency response forms more 

accessible and easy-to-use, select the editable form from the Snap Plus References.   

 
Figure 9.  Choose "Help” then "References" to review nutrient management information that 
includes an editable emergency response plan form. 
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Field Screen 
 

NRCS Soil survey updates – The NRCS soil survey mapping unit lists for each county  are 
updated in Snap-Plus through February 2007.  

 
N Restrictions - The Field screen has a new "N Restrictions" column to help minimize N 

leaching to groundwater on high permeability soils, or soils with less than 20 inches to bedrock, 
or soils with less than 12 inches to apparent water table.  A list of soils with a high potential for N 
leaching to groundwater is provided in the updated, (4-20-2007) Appendix 1 of the Wisconsin 
Conservation Planning Technical Note WI-1 found at 
http://www.datcp.state.wi.us/arm/agriculture/land-water/conservation/nutrient-
mngmt/planning.jsp.   

 

 
Figure 10.  The N restrictions are shown in the Field and Cropping screens for each field.  Click 
on the “?” in the Cropping screen to have the restriction defined. New version adds new "N 
Restrictions" column & removes existing N restrictions in "Field notes" in the Field screen. 
 

NRCS Soil survey Maps – Farm maps can be retrieved from the NRCS Web Soil Survey via 
the internet link found on the Field screen (Figures 11, 12, 13, and 14). 

 
Figure 11.  Retrieving a combination topographic and soils map. 
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Figure 12.  Retrieving an N-restricted soil “R” bedrock map.  
 

 
Figure 13.  Retrieving an N-restricted soil “P” highly permeable soils map. 

 

 
Figure 14.  Retrieve an N-restricted soil “W” wet soils map. 

Field  
N-Restricted      
W soils (wet) 

12 inches to apparent water table. 

Field  
N-Restricted   
P soils 
(permeable) 

20 inches to bedrock is about 50 cm.

Field  
N-Restricted 
R soils 
(bedrock) 
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Note that the wet soils map in Figure 14 may include some soils with perched water tables that 
are not actually subject to N application restrictions. Compare this map to the N restrictions 
column on the Snap-Plus Field screen to ensure that no unrestricted soils are included. 

 
Soil Test Screen 

 

 
Figure 15.  Above shows that the most recent soil test is listed first. 
 

Nutrient Sources Screen 
 

Copy sources and fertilizer – Nutrient sources can easily be added and copied to any year in 
the future or past. 

 
Figure 16.  Select nutrient sources and the years where these sources should be copied as shown.  
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Livestock estimator & animal-unit-calculation – The livestock estimator has been updated 

to provide annual manure production estimates and animal units calculations.  You will also find 
web links at the bottom of the page for technical references. 

 
Figure 17.  The livestock estimator has improved animal unit calculations. 

 
Cropping Screen 

 
Note: When you enter data from the Cropping screen, you are applying manure and/or 

fertilizer for the current crop year and field only.   
 

Calculates manure nutrient applications to a field from rates, total manure applied, or 
from animal grazing –  
1.  You can enter the field rate (in tons/acre or gal/acre for manure— the appropriate manure and 
fertilizer units will appear automatically depending upon the source selected).  You can add as 
many separate applications as you like.   
2.  If you know the total amount of manure applied to a field in tons or gallons, click on the 
ellipse in the rate cell to enter this amount and the program will calculate the per acre application 
rate for the field as shown in Figure 18.   
3.  If you have chosen a grazing spread method, clicking on the ellipse allows the application rate 
to be calculated through the Grazing Nutrient Rate Calculator as shown in Figure 19.   

 
Figure 18.  Use the ellipse box to enter a total amount of manure for calculating a field 
application rate. 
 

Calculates Grazing Nutrient Rate – For operations needing to determine nutrient 
application rates for manure deposited by grazing animals, this calculator provides a method.  
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Rate calculations can be determined for a single application or for the entire season if you choose 
grazing as the nutrient source and spread method as shown in Figure 19.  

 
 
             Figure 19.  The use of the grazing calculator is shown above starting with the Nutrient 
Sources screen and then the Cropping screen to add nutrients. 
 

Biosolid nutrients - Nutrient credits for biosolids (sewage sludge) are calculated differently 
than for manures.  If you need to enter biosolids applications in Snap-Plus, get the explanation 
handout from the Snap-Plus download site.  Future versions of Snap-Plus will have a biosolids 
nutrient analysis data entry feature. 
 

 
Figure 20.  To find information on using biosolids nutrients go to http://www.snapplus.net/.  
 

Snap-Plus years are crop years - Crop years in Snap-Plus include the months from harvest 
to harvest.  Some of these months may actually be in the previous calendar year.  For the example 
shown in Figure 21, the 2007 crop year soybeans are chisel plowed on 11/3/2006; planted on 

Proc. of the 2008 Wisconsin Fertilizer, Aglime & Pest Management Conference, Vol. 47 127

http://www.snapplus.net/


5/12/2007; and harvested on 10/14/2007.  This field is planted into corn in 2008.  For that crop 
year, manure is fall applied in 10/31/2007, planted in 4/20/08, and harvested in 10/24/08. 

 

 
Figure 21.  The Snap Plus cropping year is from harvest to harvest and usually includes months in 
the previous calendar year. 
 

Double crops – Double crops are when two crops are harvested in one crop year.  For 
example, the first crop could be a winter grain harvested for forage in the spring and the second 
crop of soybeans is spring-planted crop and harvested in the fall as shown in Figure 22.   

 
Figure 22.  Shown above is a winter rye forage to soybeans double crop.   
 

Cover crops – Cover crops are used to reduce soil loss and improve soil quality following 
low residue crops.  These crops are not harvested.  An example is winter rye planted after corn 
silage and killed in the spring without harvesting as shown if Figure 23. 

 
Figure 23. Cover crops are shown with corn silage above. 
 

RUSLE2 soil loss – As shown in Figure 24, Snap-Plus now predicts the average soil loss 
using the RUSLE 2 model for the crop rotation by treating the entire rotation as a continuous 
management string of crops following crops, rather than treating each year as its own rotation and 
the averaging as in past versions.  This is how a conservation planner currently uses the model to 
determine erosion rates. 

 
P Index - No longer takes a “worst-case” approach.  This model accounts for the likelihood 

of runoff following manure applications based on field conditions and seasonal precipitation 
volumes.  It no longer shows “Acute loss (unfrozen)” PI.  P in runoff immediately following 
manure applications to non-frozen soil are accounted for within the Particulate PI and the Soluble 
PI values.  These losses are small compared to the over-all increased annual P losses caused by 
the increased surface-soil-P from manure applications.  P losses in runoff from manure applied to 
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frozen soil can be comparatively high; therefore, the Acute Loss (frozen) PI remains as shown at 
the very bottom in Figure 24. 

 
Rotation Wizard – Shown at the top left hand corner of Figure 24 is the Rotation Wizard.  It 

allows Snap Plus users to develop crop rotations and field attributes such as contour farming, and 
to choose maximum return to nitrogen (MRTN) needs for multiple fields.  Field contouring can 
also be set for rotation in the “Rotation Settings” box on the Cropping screen.  The Rotation 
Wizard will fill-in the crop, yield, tillage, soil test date, and the soil test nutrient recommendation 
for each year of the rotation and for multiple fields at one time. 

 
Figure 24.  The cropping screen shows five years of crops in the crop rotation, field attributes 
such as contouring, and the rotation summary of average soil loss and P Index, P2O5 balance, 
K2O balance, and the details of the P Index.  
 

Corn Maximum Return to Nitrogen (MRTN) Application Recommendations – The 2006 
UWEX Publication A2809 has new N recommendations for crops.  In Snap Plus, the corn N 
recommendations default to high end Maximum Return to Nitrogen (MRTN) starting in the 2007 
crop year as shown in Figure 24.  In years when corn is planted, you can adjust the MRTN ratios 
based on corn and nitrogen price by clicking the MRTN ratio box under the soil test date as 
shown in Figure 24.  The table in Figure 25 will appear and can be adjusted based on the 
operations costs and sales.   

 
Figure 25.  Snap Plus will default to the high-end of the MRTN range for corn fields.  The range 
can be adjusted by clicking in the MRTN box under the soil test date. 
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Nitrogen Application Flags from Snap-Plus User’s Manual Appendix A and B 
 

Appendix A of Snap Plus User’s Manual MRTN Rates for Corn - For the 2007 cropping 
season, UW Extension instituted new, more flexible guidelines for determining the economic 
optimum nitrogen rate for corn based not only on soil characteristics but also on the previous crop 
and the nitrogen to corn price ratio ($/lb: $/bu). These recommendations are known as the MRTN 
rate, which stands for “maximizing economic return to nitrogen”. This system allows users to 
pick the appropriate N rate from within a range of rates that provide profitability within $1 per 
acre of the MRTN rate. A full description of this recommendation system can be found on p.29 in 
UWEX A2809 Nutrient application guidelines for field, vegetable and fruit crops (pp 29- 32) 
(http://learningstore.uwex.edu/pdf/A2809.pdf). A summary table of MRTN rates can be found 
under the Snap-Plus main menu by clicking Help, then References, then selecting 
NPM.MRTN.0307.pdf.  
 

When should you use the default MRTN price ratio? - UW-Extension recommendations 
suggest leaving the MRTN Price Ratio at 0.05 level if the crop is corn silage and it is being grown 
for maximum yields rather than maximum return to N or if manure is the primary N source and 
the land-base for spreading is limited  
 

When should I select the high or low end of the range for a given price ratio? - You may want 
to select the high end of the range in the following situations:  

 If there is more than 50% residue at planting  
 If all N is from organic sources (Legumes and manure)  
 On soils with less than 2% organic matter (applies to medium and fine-textured soils and 

medium yield potential coarse-textured soils)  
 If preplant soil nitrate test credits are used  

 
Select the low end of the range if the corn is on medium and fine textured soils with greater 

than 10% organic matter or if there is a likelihood of carryover N (residual N) from the previous 
year and the preplant soil nitrate test is not used  
 

Appendix B. of Snap-Plus User’s Manual Avoiding Excessive Nitrogen Applications in 
Snap-Plus - This appendix describes the maximum N application rates allowed under the 
Nutrient Management Standard 590 for different crops and nutrient sources.  Exceeding these 
rates will cause warning messages to appear in Snap-Plus.  
 
Allowed N applications for crops other than corn or legumes:  

If commercial fertilizer is applied:  
Total N applications, including N in starter, should not exceed the UW recommended rate for all 
crops. For non-legume crops other than corn, there is only one N rate recommended for a given 
crop or, in the case of potatoes, crop and yield range combination. Thus you will get an error 
message in Snap-Plus when fertilizer N is applied alone or in combination with legume credits or 
manure at a higher than recommended rate for any of these crops.  
 

If only organic sources are applied:  
The 590 Standard recognizes that there will always be some uncertainty in estimating manure N 
availability due to the effects of variability in manure nutrient contents, uneven application rates, 
and weather. As a result, if all of the N applied in a given crop year comes from organic sources 
(manure and/or legume credits), it allows estimated first-year available application rates to total 
20% more than the recommended rate.  
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Allowed N applications to corn:  
The MRTN rate for corn can vary from year-to-year, depending on field conditions and corn 

and N prices, and is therefore not suitable to use as standard maximum N allowance. The 
maximum allowable N rate for corn is set at the high end of the range for the 0.05 Corn: N price 
ratio (Figure 13a and Table 1, column 3). These are the highest N rates in the UW-Extension 
guidelines and are recommended where manure and legume credits are the only source of N for 
fields on farms where the land base for spreading is limited. These high rates already take into 
account the uncertainties in estimating N availability from manure applications. Therefore total N 
applications in excess of the rates shown in the third column in Table 1 are not allowed with the 
following exception; If only organic N is applied to meet this maximum rate, then up to 20 lb/a N 
can be applied in starter fertilizer. Therefore, where all the N applied up to the maximum shown 
in Table 3, column 1 is from organic sources, up to 20 lb/a commercial N can be applied and 
Snap-Plus will allow total N applications as large as those shown in the fourth column in Table 1.  
 

Note:  Snap-Plus will not generate an excess N message under any circumstances if the entire 
plant-available N in a crop year is from legume credits or 2nd and 3rd year manure credits 
because these N sources are not from current year applications.  

Table 1. Maximum allowable N application for corn 
Soil  Previous crops  Maximum plant-available N 

rate (fertilizer, 1st yr available 
manure, and legume credits) 
combination of 1st year 
available N in manure  

Maximum plant-
available N rate if ≤ 
20 lb starter N and 
all other N is 
organic 

  lb/acre   
High/Very high yield 
potential  

Corn, forage legumes, legume 
vegetable, or green manures  

190  210  
 

 Soybean or small grains 160  180  
Medium/low yield 
potential  

Corn, forage legumes, legume 
vegetable, or green manures  

140  160  

 Soybean or small grains 110  130  
Sands/loamy sands-
irrigated  

All  230  250  

Sands/loamy sands-
non-irrigated  

All  140  160  

 
 Allowed N applications on legume crops:  

Most legume crops can fix sufficient N from the air to ensure adequate growth without 
applying additional N to the soil; recommended N fertilization rates are therefore zero. Legumes 
will use available N in the soil, however, in preference to fixing their own. Thus manure N 
applied to legume crops is not considered to be at risk of leaching loss if it does not exceed the 
crop N removal rate. The 590 Standard allows applications of manure to legume crops that do not 
exceed the annual N uptake by the legumes or first year removal by seeding year legumes and 
companion crops. Table 2 shows the first-year available manure N application rate allowed for 
each of the legume crops in Snap-Plus. Due to the difficulty that sometimes occurs in obtaining 
P2O5 fertilizers without N, Snap-Plus does not give an excess N warning if up to 35 lb of the 
legume N allowance (removal rate) is applied as fertilizer. Commercial N should not be applied 
to legume crops that do not have an N requirement unless it is an unavoidable ingredient of a 
fertilizer needed to provide other required nutrients.  
 

Allowed N applications on soils with a high nitrate leaching potential:  
Soils that have a nitrate leaching potential are identified in the N restrictions box on the field 

and cropping screens. If a summer or fall manure or fertilizer application is made on a field with 
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N restrictions, the following notification appears in the Nutrient Application Planner. “This soil is 
restricted for late summer and fall N applications.” See Nutrient Management Standard 590 
criteria B on page 5.  
 
N applications restrictions on high nitrate leaching potential soils for fall applications are:  
1.  No fall commercial N applications except for no more than 30 lb/acre on fall-seeded crops. 
Late-summer or fall manure applications when soil temperatures are greater than 50º, are allowed 
only if you use a nitrification inhibitor with liquid manure and limit N rate to 120 lb available 
N/acre; or if you apply after September 15 at no more than 90 lb available N/acre; or if you apply 
to perennial or fall-seeded crops at rates to meet the crop N requirement but not exceeding 120 lb 
N/acre.  
N applications restrictions on high nitrate leaching potential soils for fall applications are:  
2. Fall manure applications when soil temperatures are less than 50º are allowed at rates not 
exceeding 120 lb N/acre.  

Table 2. First-year available manure N app. rates allowed for legume [& companion] crops 
Crop  Yield range  Manure N allowed (lb/acre) 

Alfalfa, alfalfa/brome, red clover  all 110 
Alfalfa, alfalfa/brome, red clover seeding  No harvest 60 
 1.0 - 2.5 ton 190 
 2.6 – 3.5 ton 220 
 3.6 - 4.5 ton 280 

25-50 bu 150 

51-75 bu 180 

Barley w/ alfalfa, alfalfa/brome, or red clover seeding  

76-100 bu 210 
10-20 cwt 60 
21-30 cwt 100 

Dry beans  

31-40 cwt 140 
30-60 bu 150 
61-90 bu 170 

Oats w/ alfalfa, alfalfa/brome, or red clover seeding  

91-120 bu 190 
Pasture seeding, grass/ legume  0.5 - 1.9 ton 80 

2 -3 ton 110 
3.1 - 4.0 ton 150 

Pasture, not-rotational or rotational, grass/legume  

4.1 - 5.0 ton 200 
Small grain silage underseeded with alfalfa  2 - 3.5 ton 170 
Small grain & legume silage  2 - 3.5 ton 210 
Small grain & legume silage underseeded with alfalfa  2 - 3.5 ton 210 

15-25 bu 80 
26-35 bu 120 
36-45 bu 160 
46-55 bu 200 
56-65 bu 240 

Soybean  

66-75 bu 280 
*Some Snap-Plus legume crops such as peas and snap beans are not included in this table because N 

removal in the harvested portions of the crop is similar to their N fertilizer recommendation.  
The above restrictions allow some flexibility in making late-summer and fall manure 

applications, but do not under any circumstances allow more than 120 lb available N per acre to 
be applied at that time. If fall available N applications total more than 120 lb N per acre, the 
following message will appear in the Nutrient Application Planner, “Excess N according to limits 
set in the Wisconsin Nutrient Management Standard 590: This field has fall or late summer N 
applications in excess of what is allowed for soils with a high N leaching potential.” These 
applications will appear in red on the cropping screen.  
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